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From the Chairman Clive Haynes FRPS 

r>ear Fellbw r>tc:; nttntbers 
As I write, the D-Day event at Rugby in October is becoming more distant as we look towards the new year 
and plans for 2007. The D-Day event turned out to be more controversial that we would have pre­
dicted or wished for and a little background information may be helpful. 
For some 10 years the group has organised an annual digital day under the broad title of The Spectacular. 
The event repeated the same formula of lectures. exhibitors, informal talks, members' print exhibition and 
prize draw. The day also fulfilled a social function: here members could meet, share ideas and renew 
friendships. 
The committee had realised that for a couple of years the attendance was reducing and the exhibitors were 
becoming less than enthusiastic. Earlier this year the committee decided it was impractical to repeat The 
Spectacular. Another approach was needed, including a different emphasis and the change in name 
reflected this. Originally Barrie Thomas FRPS was to 'headline· the show and we were all saddened 
by his death in July. We decided to continue with the event and DI industry guru, writer and lecturer John Henshall FRPS accepted the 
challenge. John made his plans for the day, which would incorporate his style and presentational ideas. The RPS membership 
is broad based. embracing almost all disciplines of photography and associated imaging. John wished the event to appeal to as wide 
a cross section of photographic digital imaging users as possible. 
The committee worked exceptionally hard to organise the day and this aspect worked better and more smoothly than ever before. 
It's not my position to deal here with the individual comments that arose during and after the D-Day event. If you are interested in 
reading the spectrum of opinion, then I suggest you visit the DIGIT Forum web pages. We have received numerous messages about 
the event expressing views both critical and in appreciation and the committee will be digesting the various opinions. 

Growth In the North 
The Digital Imaging Group continues to expand and attract new members. To accommodate this trend we are pleased to announce 
that a new DIG Region has been founded - the Yorkshire Digital Imaging Group. This new group has been coming together since the 
spring of this year. We are grateful for the initial work put in by Terry White and now to Robert Croft who has tal~en on the role as Digital 
Imaging Group Regional Organiser - DIGRO for short. We congratulate all concerned on this initiative. Details about the Yorkshire group 
meeting in February are given on page 31 of this issue. 

What about Northern London/Mlddlesex you ask? 
It's a curiosity that whilst Regional Groups flourish in many parts of the country, one of the most densely populated areas remains 
without a local group. This is the area around the northern limits of the M25/Middlesex - and we often receive enquiries from 
people wishing to know of one in this general location. So if any member wishes to start a digital group in this area, please con­
tact a member of the DIG committee, 

Stop Press - DI Group Resldendal Workshop In Dlgltal Portraiture and Photoshop 
Aprtl 9 - 11, 2007 at West Dean College, Chichester, Sussex 

Limited to just eight photographers, you will have sole use of a PC for this two full day workshop. Portrait studio with full 
professional lighting in a historic house room with Graham Whistler FRPS and Clive Haynes FRPS running the Photoshop 
computer room. Monday evening 9 April: welcome, dinner and introductory session. Tuesday 10 April professional male charac­
ter model for the whole of the day with one-to-one guidance from Graham. Work on images with Clive in the computer room. 
Studio and computer room available all day and evening. Wednesday 11 April young female model for a three hour morning 
studio session. Preparing images and prints for display with Clive throughout the day. Depart for home at 1600. Likely cost: 
£222 for single room with all meals, non-residential students, including lunch £150, plus a cover charge of £8 per student 
for models. Please contact: Graham Whistler FRPS Email: graham@gwpmultimedia.com Phone: 01329-847944 for more details. 

Latest Distinctions for DI Group members 

We are delighted to congratulate the following DI Group members 
who have recently gained distinction. If we have missed your 
name from the RPS records do please let us know of your 
success. 

Fellowship: Len Deeley; and Charles Frewin 
Associate: Nick Ayers, Norman Carey; George Hodlin; and 
Celia Paren 
Licentiate: Michael Arnison; Clifford Marsh; John Stringer 
and special congratulations to Sir George Pollock Hon FRPS for 
getting off the mark rapidly with a Photo Harmony L distinction. 
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Spring 2007 DIGIT 
The next issue is already in the planning stage with printing 
scheduled for the end of February. But I still need lots more 
of your images and articles. What a nice Easter present to 
see your photographs in DIGIT! 
So here's how to do it. Let me have anything from from 300 
to 1200 words and some images. The files should be TIFFs 
at the size appropriate to your article, with a resolution of 300 
ppi. You can email them to me - see back cover. If you'd pre­
fer to use a CD please send to Editor DIGIT, 1 Aldenholme, 
Weybridge, Surrey KT13 OJF UK. Further details of formats for 

DIGIT and the annual exhibition are on page 31. Gditor 



ILEX Press image competitions - How good are you? 

of 

is reviewed on page 27 - II.EX have generously sponsored two new competitions. 
f dig/ta/ Imaging as exhibited at the Digital Decade D-DAY Rugby symposium on 

cm mounted print for exhibition on the day and. in addition to the u sua I print 
on that image! Bring the print, mounted on card, for the instant exhibition at 

straight 

ILEX's The Book of Digital Photography. 

Go to: www.llex-press.com for other titles 
and remember the DIGIT discount · see page 6. 

iS THIS A RECORD? 
After the rain by Malcolm McBeath ARPS won the online 
folio competition in October 2006. And he won it in August 
and September too! To enter your image and vote and to dis­
play and comment on images log on to www.dlglt.org.uk. 
Here are the three images which Malcolm entered so you can 
see what you are up against. Go on, have a go! 

Royal . 

• 

TI1e 

Pho_tographrc 
Society 

Have you had a look at the Society's website recently? If 
you haven't, you should. It's been dramatically overhauled 
and is now a smooth, clear tool. As well as all the information 
about the RPS there's a useful Forum to exchange views 
and seek advice and you can display your own images in 
an excellent Portfolio section which is really easy to use and 
gives you your own area. Log on to: www.rps.org 
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AGM and Members' Exhibition 
In this issue there are two special inserts: the AGM notice 
for Sunday 22 April 2007 and your entry form for the annu­
al print exhibition. It's our usual format at the excellent 
club rooms of the Smethwick Photo Soc in the West 
Midlands. Easy to reach from the motorway system and as 
centrally situated for transport as we can find for the bulk 
of our members. 
The selection of prints for the exhibition will follow the AGM 
and the judges this year are: Shelagh Roberts FRPS, 
Mel Gigg FRPS and John Long ARPS. Remember that this is 
one exhibition where we guarantee that one of your three 
prints will be shown at a number of venues around the UK, 
as well as on the DI Group website and printed in DIGIT. Get 
those entries rolling in to Alex Dufty LRPS. And book your 
lunch at the AGM with Glenys Taylor ARPS now please. 



Colour management: Printing the dght colours 
We all struggle · often frustratingly· to get our prints to look just like we saw them on the screen. 
This guidance from Phil Binks, who works in colour management at Bodoni Systems, f o/lows last 
issue's advice on getting your monitor in shape. Phil has been a keen photographer 

using both film and digital for 25 years and is concerned that you achieve a colour match from monitor to print. 
Those who read Phil's last article giving the recommendations for monitor calibration can now find out how the next 
important device is controlled - the printer. Here Phil sets out some software settings and practices which should 
help you on your way. Call Phil at Bodoni Systems on +44 (0)1895 825776 for further advice and available 
calibration systems and see Bodoni's online shop at www.bodoni.co.uk 

Prfntlng the correct colour using profiles 
Printer manufacturers design their printer software drivers to auto· 
matically change the colours of pictures, often increasing colour 
saturation and contrast in an effort to make the pictures better for 
the majority of typical buyers, We photographers are not typical 
buyers. We are more critical (I think) and know that the slight­
est change in hue can make an image look wrong. So, when the 
photographer hits the Print button, and out from the printer 
emerges a different coloured image, it can be rather upsetting! 

tion on Rendering Intent below. 

Intent and Rendering Intent 
You now realise that no two devices show the same colour, or 
have the same colour..------------~ 
gamut. This is the main rea­
son for the need of ICC pro­
filing! It is in itself the rea­
son we need to convert 
from one profile to another. 

-·-__ ,.,.. 
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How are printer profiles created? Imagine you have an image 
A colour patch chart is printed, its colour values are cap tu red using file which includes a bright -=-~--- ,1 

an input device, often a scanner or spectrophotometer. The profil- green shade. Your printing ._. .... ---~ ~~- ----
ing software records the colour values (Lab) which the printer device, though very capa-
has achieved, It then calculates a Profile for _________ ble, cannot 
the printer/paper/ink combination. print that.__ __________ __, 

Here is an example printer colour profiling patch • 
chart 

It is this Profile which the computer's Colour " 
Management Module (CIVIM) refers to, so that it can " 

" recreate the Lab values (read: correct colours) it is :: 
asked to print. 

,. 

" " 

particular shade. When converting your docu­
ment to the Printer profile, you can decide how the 
computer's Colour Management Module (CMM) 
handles that vivid green colour, and how that 
change in turn affects other colours within the 
image. This control is called the Rendering Intent. 
For photographic images, only two options are 
used, First, Relative Colorimetric - in the exam­
ple above. only the vivid green pixels would be 

One printer, one paper, one proflle : 
Each paper also needs its own profile. Matt paper ._" _________ changed to the nearest colour which the new 

device can output. In the second. Perceptual 
doesn't exhibit the ink colours in the same way that 
a Gloss paper does, making the colour different ... and of Rendering, all of the pixels in the image are changed in relation 

to the move of the out-of-gamut pixel(s). in order to retain the rela· 
course different manufacturers' inks require their own profiles. tional differences between the colours. 

Printing using ICC profiles 
Below are the settings to be used for Adobe Photoshopw v5.5 
to CS. Select File>Print with Preview. 

I recommend using Relative Colorimetric rendering for most 
images, as changes of colour are minimal when using wide-gamut 
devices such as modern inkjet printers. You can gauge the dif-

Page Setup ... O XP ,:~·-
Print... XP 
Print One Copy \:0:11:P 

Jump To ~ 

This brings up a 
dialogue box 
similar to that 
on the right. 
Note that the 

ference between the two rendering options on your image, by 
clicking the Preview button in the Convert dia­

------_-'.'-------- logue box. 

·-
Black Point Compensation (BPC) 

.:::. ·:. : ··"~~- Device colour spaces have different black -·····~ Show More Options is ticked. The important ,._ _ _ points. Imagine that a Matt paper can't print 
area is circled in red: this is where you select ~::::.=." as black as a Glossy paper. When convert-
your printing Profile and Rendering Intent. =--~-_.,. .. ,_ ing one profile to another, with BPC on, it will ,_.., ..... ,,_, ._ .. , ..... .__., 
Using Adobe Photoshop·;,; CS2 (v9) The set- map the source's blackest point to the des-
tings are slightly different for printing calibrat- tination's blackest point, along with the full 
ed output from the CS2 version. so here they L-========:::::::== __ _J dynamic range. This helps extend shadow 
are: Color Handling: Let Photoshop Determine Colors detail and the overall tonal impression of the image within its new 
Printer Profile: Your printer/ paper profile colour space. 
Rendering Intent: Relative Colorimetric - explained in the sec-

4 



Perceptual rendering has sometimes been called Photographic 
rendering. Many scanners and applications use Perceptual ren­
dering intent by default. Perceptual rendering often leads to dis­
appointing results, especially when printing, as it only takes one 
pixel to be well out of the gamut of the printer. to cause a change 
in all of the colours of the image when it is converted. 

Printer Settings 
To produce predictable colour calibrated prints you need to turn 
off ALL colour changing features within the printer driver. These 
include Sharpening, Automatic correction, and colour controls 
offering such luxurious temptations as Evening or Skin tone set­
tings. Below are examples of both Canon and Epson Printer 
Driver interfaces, showing where you can turn off the main colour 
changing features. 

You must use the same printer settings to print with a profile, as 
the settings used when printing your patch chart and creat­
ing the profile. These settings include: paper type (this governs 
the quantity of ink sprayed on the paper); printing 
resolution/dpi; print Quality; and speed settings. Colour 
Adjustment is always OFF/NONE. 

Canon's driver interface 

Pr.rm::, l99SO t-\'Y 

Cofo1· 8.:-1,,n••. O --<>---
o __ ,,,,_ __ 

0-----
0 ---C>---

Epson's Driver interface 

Prl111 

Printer: '. Stylus Pro 4800 

Presets: ' Epson 4800 Olmtc Glossy a.nd ... Ii) 

: Printtr Colo, M.tnagemtnt ~ :j,-1-----

0 Color Conttofs 

i) ColorSync 

8 Off (No Color AdjllSttnent) 

Tip! 
Save the settings in the printer driver Presets then you can 
easily select them when you need Profiled/Colour calibrated out­
put. 
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Creating your own profiles 
You can create your own colour profiles using products whereby 
you record colour patch data in the profiling software. The soft­
ware then calculates the profile for the printer/paper/ink combi­
nation. The whole process is extremely simple. Prices range 
between £150 and £1000 based on accuracy and other features. 
Call me for advice. 

Print Drying 
Mal(e sure that you allow sufficient time for both your pro­
filing patches and your subsequent photographic prints to dry. 
Even instant dry prints undergo gradual colour changes during 
the first hour. Do not speed dry your prints! 

Printing Profile Names 
The profile name should clearly define the Printer model and the 
Paper type - for example Epson4800SuperGloss 

Using Canned Profiles 
Epson often provide a number of profiles for Epson papers for use 
on their printers. Canon paper profiles are nowhere near as obvi­
ous. They are held deep in the system, so that they are automat­
ically utilised if you find the right settings in the driver' Other 
printer manufacturers may do the same. 

Canned Proflles - Limitations 
The limitations of using a canned profile are that the man­
ufacturer only provides profiles for their own branded inks and 
papers. The profiles have been created on a different printer from 
yours, and yours is likely to perform differently, especially when 
you realise that firmware development and other changes to print­
er/ paper /inks may have taken place since their profile was creat­
ed. You are not informed of the settings they used when creating 
the profiles, so achieving accurate colour output is hit-and-miss or 
pure luck! 

Ughtlng Issues -Viewing Prints 
Consideration has to be given to your print viewing conditions. The 
likeliest cause of initial disappointment when assessing print 
colour is the lighting conditions under which it is viewed. Evaluate 
your print in daylight. Viewing a print under artificial lighting con­
ditions, tungsten or fluorescent tubes/strip lights, is likely to be 
futile and betray artificial differences in colour. Both Inkjet and 
photographic papers suffer from a phenomenon called 
Metamerism. the visual change of colour in an image when 
viewed under a different light source, such as that between day­
light and fluorescent light. Don't be too quick to bin the print if 
you are printing it in the evening: wait until the cold light of day, 
or better still a northern window on a sunny day' Your monitor 
calibration assumes this type of lighting. 

Contact me on 01895 825776 for additional advice 
and calibration equipment and remember that Bodoni 
Systems offer Colour Management training on a one 
day course at our offices in Harefield, Middlesex. If 
you'd like more details please ring or email me on 
phil@philbinks.co.uk, mentioning DIGIT. 
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for cligital photographers 

In the book review for this Issue we take a look at ILEX Press' 
fourth volume In the Cookbook sertes - Photoshop Fine Art 
Cookbook for dlgltal photographers. And we also take a glance 
at two rather different books from the same stable which are Just 
out featuring some brllllant concepts on llghtlng In dlgltai 
photography. Could be Just right for your Christmas book present? 

ILEX's Cookbook 
series has four relat­
ed volumes and 
three have already 
been reviewed sue-

,__"_' ___________ ___. cessfully in DIGIT. 
This is the fourth in 

the Digital Studio series. A How To book which claims to show you 
ways of mimicking the great artists and photographers' styles? I was­
n't convinced when I first opened ILEX's title. After all why would 
I want to recreate Roy Lichtenstein's pop art dots? But when I 
started on the book I realised how author John Beardsworth - who 
also authored the Blending Modes Cookbook - was taking the 
reader through the connections between art and photography. In 
the first section he offers a crash course in art appreciation: the 
works of the Dutch portrait painters, Turner, Van Gogh, Klimt 
and art nouveau as well as Japanese print making are explored. 

John Beardsworth also devotes space to many of the early 
photographic techniques such as calotypes, wet plate collodian 
and platinum paper through to cross processing with a couple of 
pages on each to show you how to create their unique look and 
feel. For example, for platinum he offers the data for toning 

§1.§~ 
= 7.·.:==:=:.:-
____ 
- ·--
~~-

~~ 

My eye was especially caught by how to do an Ansel Adams, a 
great hero to most of us over a certain age. I've never had the 
good fortune to visit Yosemite but I wondered if the Rockies might 
do. To test the value of this book I simply followed the instruc­
tions in the spread shown opposite. 
Here is my scanned transparency without enhancement taken in 
British Columbia about ten years ago. Pleasant enough as a 
travel record shot but lacking impact. 

, , 

The technique is to add successive adjustments layers -
and of course this is not limited to Photoshop - and to con­
sider carefully the effect on each part of the picture. You 
can then mask out areas where you do not want that 
effect. or that intensity of effect. A couple of Curves 
adjustment layers, some dodging and burning as Ansel 
Adams himself would have done and 20 minutes later I 
had this image. Not Yosemite and not Adams of course 
but with rather more concentration and careful appli­
cation I could see that I would be able to create something 
closer to the master's style. 

adjustment layers using curves in Photoshop CS2. 

Other sections concentrate on the use of non-destructive adjust­
ments - that is, those that do not permanently change or destroy 
the pixels in the image and can be undone or further modified -
essential when working on multiple, complex changes to an 
image. 

You can order on line at: www./lex.,.press.com where you get 
20% off any /LEX. cover pries. But D/Gff members do even 
b8tter by using the the discount code DIG773RPS24llsx 
Which takes off another 10%. Just click on 'buy' for any 
book and add the code Into the box prorldt1d when chscldng 
out to get the extra 10% discount. 
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Just published by ILEX ing to an existing photograph. Looking through the techniques 
received for review.-------+--------------~ it's amazing what 
are international pho- can be done with 
tographer and writer RMALINGsHAoows the basic pro-
Michael Freeman's gram Elements 
Light and Lighting in and many of the 
Digital Photography techniques will, of 
and multimedia course. carry over 

I_ 
trainer and digital to other similar 

designer Barry Huggins' Photoshop Elements ~ d imaging software. 
Drop Dead Lighting Techniques. ._ . . _ _ As ththe pubbliskhers

11 
These are two very different books coming at the say, is 00 wi 
same subject from varying angles. The first is a ....._ ___________________ _;;_J show you how to 
heavyweight book for serious photographers who want to under- add a touch of piuazz to your images! 

stand and exercise control over the capture and manipulation of 
light. It is bang up to date with a major section devoted to the high 
dynamic range technique (see John Miles· image on the front cover 
for an example). Michael Freeman is concerned to deal with both 
the light falling on the subject and the interpretation of that light 
through digital imaging to realise the photographers' creative vision. 
This leads into complex digital lighting effects. White balance, 
clipped highlights and dynamic range are covered so that the pho­
tographer can extract the most out of the available lighting as well 
as constructing illumination in the software. Digital photography 
does require some different thinking on the traditional concepts to 
open up an extraordinary range of possibilities and Michael Freeman 

sets us off on that road. 

With a title including the words Drop 
Dead Lighting you can imagine that 
Barry Huggins' book is about mak­
ing that special lighting and shadow 
impact with Photoshop Elements 
techniques. So, here we have clearly 

·~ - -- laid out pages offering ideas as varied 
as creating smoke and fire to 
adding neon strip advertising light-
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So, want to produce a Hockney swimming pool, a Warhol 
silk screen print or even an impressionist landscape? Or 
like me, an Ansel Adams-like rich monochrome landscape? 
Or do you fancy getting your head round lighting in digital 
Photography for your after-Christmas lunch read? Or is your 
program Elements and you want to impress your friends and 
photo club with some tremendous special lighting effects? 
Just go to www.llex.com to get your copy of this book and 
don't forget the special discount code for DI Group 
members · see box on facing page. 



Dlstlnctlvely Different 
Clive Haynes FRPS reviewed the Photoshop plug-in art program buZZ.Pro 3, the creation of 
Cambridgeshire-based digital wizards Fo2PiX in the spring issue of DIGIT. Fo2PiX have 
also developed ArtMaster and ArtMasterPro which, unlike buZZ are not plug-ins but 
full-featured programs in their own right , presenting a rapid way of producing distinctive, 

- : .?-~ 

ArtMasterPro 
--roe~ 

artistic images from photos without the need for Photoshop or a similar imaging program. The 
programs, which are available for PC, Mac and Mac-Intel operating platforms, install very quickly and open readily from 
a desktop icon. Here Clive explores the delights of ArtMasterPro, the more extensive of the two ArtMaster programs 
and the one most likely to appeal to serious enthusiasts, dedicated digital imagers and professionals alike. 

ArtMasterPro works faster with images that do not exceed 2,000 
pixels for the longer edge: indeed many features within the pro­
gram work better with a longer edge of around 1,000 pixels. This 
smaller file size means that image processing is quick and one 
can rapidly work through a project. In practice I found that A4 size 
images work well and loading times for the various effects were 
reasonable. As the images tend to be graphic and artistic in 
nature, printing to A3 size should not present difficulties. 
I did experiment with processing an A3 image but images of this 
size do require plenty of memory with consequent slower processing 
times. The resizing option within the program is designed to down­
size rather than upsize. The program opens and saves the follow­
ing formats: jpeg, png and tiff. When processing images the pro­
gram reduces any 'internal losses' by using bmp files. 

Getting started 
Once installed you'll want to use the program and discover what 
it can do. I'm going to use four images as example pictures and 

-.. . 

work through several stages 
of art-image making to 
illustrate the two main 
routes the program 
offers. One can either 
choose one of the many 
step-by-step ArtWizards 
or the more free-ranging 
Manual alternative. 

Working with a Wizard 
L~.l 

_.) ArtWil'.vds 
• ...J BAQ(t\l MO<llt1Glfl' 
• .-J ftASJC FOPM 

The numerous ArtWizards are presented as 
a drop-down list. This screen-grab shows 
the list of wizards with Distant View • .-J Bl.EAC.rEO WATER.CCtOUR 

opened to reveal its contents. .: ;j=~~·"' 
Upon opening an image one can make cer- ~ ;j~:=:,~·;~ ,_ 
tain basic adjustments by clicking on the : ~:':"r=z...n. 
Adjust button at the base of the program : ::~:: c;::~;~ 
window. : ::;:~ ;~f2P 

• Step 6 · ~ s.f2J.I 

These include brightness, contrast, hue . .:.J F!kELIC,Hl 
' _J POl'AAJ: 

and saturation, which are slider controls ;.- ...1 POPAAr2 
I -J SO,,O OU\£ 

and can be advanced incrementally by the · _isms,a , PENCn. 
• _J SEPIA AG:. 

keyboard arrow keys. In addition there are ., ...J SLfoNER GRAs, 
~ _J W ARM W A T'f.RC:OLOl.lt 

buttons for horizontal and vertical flips, _._ _ 1~ ' "'1SH= ,ouotes 

clockwise and anticlockwise rotation and invert (make negative) 
the image. The Adjust window also includes Crop and Resize 
options. 

I • 
1 

~ -
11 

~ -
11 

~ ,.- l t~s.r., ,I Clicking the Studio 
• ·-···· • button at the base of 
the program window opens a set of ArtWizards and reveals the 
ArtWizard button in the left-hand area of the window. 
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As one progresses through the stages of making a picture, context­
sensitive help and useful prompts appear at the top right of the 
window. These can be toggled on and off by using the F6 key. 

There is a zoom in/out slider control at the base of the screen 
area. Once zoomed-in, one can navigate around the image by sim­
ply holding down the space bar, clicking and dragging the picture 
around. 

As an introduction to the program, I'm going to work through an 
image using the ArtWizard, Distant View, as it includes artistic 
effects suitable for my pre-visualisation of the picture. 

After selecting Distant View and opening the first choice on the 
menu the ArtWizard button is clicked and the opening screen 
appears. 

The first step allows a choice of canvas colour to be made. This is 
....... .,,.,,...-------- called Solid Colours and a full 

J 

- r.--
- - ..c...;;:;;;. 

spectrum is on offer. I chose a 
pale cream for this exercise. 

Fo2PiX have introduced the idea 
of two-dimensional controllers 
for the contents of the Palette 
and for the way the Palette is 
mixed to the Canvas. Thus the 
H/S Picker controls the Hue, on 
the horizontal axis and 

·• ,.:-},,_ , - ! :~ Saturationf on the vertical axis: ....__ __ ....:.......:.;:.:.:.::.:.::=.:.;;;;... __ __. 

the B/C Picker controls the 
Brightness on the horizontal axis and Contrast on the vertical axis. 
Rather than having to select a Blend Mode then set the amount of 
that blend, ArtMasterPro again uses a two-dimensional con­
troller for the A/B Mixer: the Amount of the blend is on the hori­
zontal axis and the various Blend Modes are on the vertical axis. 

The Wizard Guide shown here is a .. "'-.-",-11--,t.-·,G-,,OE-----­
useful prompt for each step. : .. ~~~=:,t atAe>-.leOa~unaek~ 

Progress through the Wizard is by ~~J:~~~~~~:-.;:i:':~:. 
tfust!Slroktt.\. 1111 _,.stlon 111oditit 11.., Olf»tll WlliRaro 

clicking the Continue button. ,u ......... . . . ,,,~. ""' "'""''"""···"·"' .. 
Ptt,1!; l,O'tf.m.111 U1 S-..:;• 3 

S'ltP 1 Yo...-.ffP*-'IPPIWeOlou:s 

Having set the background canvas s ... .v .. ""•"""""oo'""' .. "' 
SWp ~ Yoo ~1Jo;anurrallW'lllt fllONl!1H 

colour, Step Two is where we begin ""•6Y00 ~•• ... ,n ... ,,,..,,,.,,,,.. 
to paint in the picture. In this wiz- • .,.iw..,1" 

O.SMlft.ara-.oru bt•, !tit ~lJtffl:tt yoo ongi11.1 """9* 

ard, the first effect is from the :::~"!.."':':.::::;.:.~."~:,:,-::~"'"'"'"" ... 
Frazzled Colours range where 14 dif- ~:·;:..-;:.~,::.:':':::.~·::i.':'0 "' 
ferent options are offered. A series 51!.io, -.,ii>,~ ng,.. 

of image thumbnails is presented as ::"=:~:r::vcu-on~~ 
an indication of what each option ..... e",.,.,,.,., .............. . 
offers. Clicking on a thumbnail causes a larger version to appear 
in the Studio window 



~~~~~~""'T'!"-~------, at the left corner. I 

i]-

To paint in the image (a method 
with similarities to cloning in 
Photoshop) the brush size, shape, 
softness and rotation can be edit-

decided to start 
with Frazzled 
Colours - choice 1. 

...._ ________ ~ 
ed according to need. With a 
series of brush strokes the image is recreated using the effect 
selected. It's a matter of artistic preference as to how much of the 
image is revealed in this way. 

After working on the image with the brush, one may wonder what 
another option would have looked like. All one needs to do is click 
on another thumbnail from the display and the image will adopt 
the effects of the alternative treatment. As an experiment. I select­
ed Frazzled Colours 10 and got this. 

If you wish to erase or 
paint out a brush stroke at 
any time, hold the Shift 
key whilst using the brush 
and the tool will operate 
as an eraser. 

Advancing to the next 
step, I chose Rippled 

._ ___________ ___. Colours 1 and applied the 

,----------------, brush; this had the effect 
of making the fresh areas 
painted, together with 
those over-painted, becom­
ing richer in tone. 
At any time, the three 
icons controlling H/S, 
B/C and A/B are avail­
able and the screen 
grab below illustrates the 

....._ ___________ __, effect of setting A/B at 

80/24, making the image denser in this instance. 
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The next step for this wizard is Main Colours which creates more 
density, then White Highlights and so to the final step in this wiz­
ard of Fine White Highlights. These highlight features add sharp 
fine details to the image. With the wizard steps completed the pic-
ture is ready for printing. 

My image Najac, with the original shown smaller below, was also 
processed using a wizard; in this instance l selected Summer 
Grasses which quickly gave a pleasing result, going through an inter­
mediate stage with Drawn Edges to create the the final result. 

Going Manuai 
The alternative to using a wizard is to edit the image purely 
manually, selecting from the hundreds of options and settings 
available and experimenting. After a short time I found that I 
became quite good at predicting a likely outcome and I was also 
able to adjust the three principal controls for Brightness, Contrast 
and A/B balance with a high degree of~~~~~~~~~ 

confidence. After each step the image '-==M=aru=~===]._I _k_tWi_12a_rd_ 
is 'fixed' and one can proceed to the ,.. J 

Record 
next artistic option as required. 



Edges - Shaded Edges 

Edges · Rippled Edges 

.... - .- - - ··- - --
11!1 -S~i .;,_ · 1 j -.. i ::, ::x.· 

I . 

Masks · Rough Surfaces 16 

To give an idea about how the Manual operation works. I show the 
steps I used in producing the picture Ben above, together with 
options and alternatives. After resizing the image in ArtMaster Pro to 
A4 (9MB), I decided to make a pencil sketch of this picture. To do 
this I worked with Edges & Outlines> 
Drawn(shaded) Edges · Rippled Edges, Mask>Rough Surfaces. 

When I was happy with each stage. I fixed the image and con-

,~,,;~-, .. , 
°C'.1:' . -v-

I Applying Frazzled Edges I 
,_ c_ . .,_. 

~ - ..__"'\"'< r,·••• _ , . ,. ..,...,., ---_ ..._ 

~r..:Y i } t " -.. ~"' Tip\ .,~:,_· ~r.:1.· 1-i~fl r1;.., · r.t~ ·? Y ro~ ~i(t? -~ , !le,, ) 

Ben Final sketch 

tinued to the next. The steps included adjusting Brightness, 
Contrast and A/B balance, re-painting and over-painting as need­
ed. 
The next example I chose was the Rifleman picture below. Here, I 
worked with two options: the first was to make a sketch and 
colour wash and the second was to produce a light charcoal style 
sketch over a pale cream ground. 

Painted Version 



Other Options and effects 
As with any image manipulation program the range of options and 
combinations of settings is almost limitless and ArtMasterPro 
presents a vast choice. 

Masks and Surfaces may be applied to the image and these are 
editable in much the same way as other features within the Studio 
facility. The surfaces may be used to add texture to a picture 
whilst the masks present overlays of stark contrast and semi-solar­
isation, Used subtly they can add another dimension to the 
image. My image Rifleman illustrates the use of a mask. 

Combinations 
If needed, it is perfectly possible to swap in and out of Wizard and 
Manual modes, choosing effects from each as you go. 

Recording 
One can record the manual steps made in the Studio, fixing each 

stage as the work progresses. Steps recorded in this way can be 
saved as your own ArtWizards, ready for use. 

Summary 
ArtMasterPro presents a quick workflow towards achieving artistic 
pictures. The wizard and manual interfaces are simple to under­
stand and one quickly becomes familiar with the method of work­
ing. 

As with all art programs, the styles and effects generated are not 
a recipe for instant artistic success. One needs to apply a treat­
ment that is sympathetic to the image chosen. 

Continued exploration of the program reveals many subtleties of 
operation. Here you can make pictures that are distinctively 
different. I can recommend ArtMasterPro as another step 
forward towards our better realisation of a picture. And what's 
more, you'll have fun doing it! 

And finally ... A Mission. The design and innovation talent behind Fo2Pix have a mission to produce highly editable imag­
ing programs with branching options that extend the boundaries of image manipulation and future programs will embrace 
these ideals. In the words of Kevin Gilbert, CEO of Blue Pixel Inc, the US's leading photography educators: 'Fo2PiX has found 
an incredible solution to the agonising dilemma of using multiple layers when editing images and trying to share huge lay­
ered image files with colleagues. The company has solved the problem of how to record every what, how, and where, together 
with each tool that was used, so now you need only save or email the original image plus the complete history of interactions. 
This major breakthrough will allow users to record, replay and share their edits completely non-destructively.' 

For details about the latest price see www.Fo2Plx.com. 
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I enJoy writing and teach English and Design Technology. 
This is the start of the 4th year of my being interested in dig­
ital imaging. I never liked film photography and bought a 
digital SLR almost immediately. I have been on several 
week long workshop and also travel on photography trips 
with a friend. I am a member of Cheam camera club, 
Epsom camera club as well as the Central Southern Digital 
Group. I also put in work for the SPA. I was awarded my 
LRPS in Oct 2005 and was lucky enough to get my ARPS in 
April of this year. The theme was coastlines. 

I am interested in all areas of digital imaging but would say 
I am am better at the creative side than the technical wl1ich 
I manage OK. 

Several months ago I had had an L panel recommended, 
but I knew an A was a different thing altogether. I had no 
specific thoughts of an Associateship panel when I went to 
the Western Isles on a photo trip, but I was aware that I 
would like to try one at some point. I spent my childhood 
by the sea and have always had an endless fascination with 
coastlines. 

I have been digital from the start and have never been inter­
ested in film work; I'm far too impetuous! I was lucky that 
after brief experimentation with a digital compact, the 
Canon 10D came out, and away I went. I knew from the 
start I was serious about imaging. Now I have a 20D and a 
selection of lenses. 

I had been to an A panel judging day and would recommend 
that anyone who is interested should go to one. I was an 
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Joining the A tea 
Leonie Selwyn ARPS found the last DIGIT a very good read and 
suggestion for an article. Here Leonie tells us how she progre5 

State 
The island coasts where these photographs were taken, offer 
have tried to capture the endless combinations of tides, we; 

lines and estuaries. The results are fleeting, lasting son 
I hope the charm that these eleme, 

observer at Smethwick, and it gave me a real idea of the 
standard and the fun of it. If you are awarded it, that is1 

When I went only a third of the work was recommended, so 
lwas a little daunted. 

II went to the Isles with an equally eccentric friend and we 
spent the entire time in the field feverishly taking images. 
No rest and relaxation for us! I soon discovered that the 
amazing quality of light in the Isles also meant very wet 
weather. We really needed the protective gear we had 
bought for the camera equipment, as well as ourselves. 
Several times a day we got very wet, or ran for non-existent 
shelter. We had rain, snow and heavy hail! 
We soon learned to cope, but I'm not sure it 
would be to everyone's taste. Sometimes we 
waited for the storms to come over, and some­
times we screeched to a halt on the single­
track roads and leapt out as they moved over 
our heads. Photography on the Western Isles l!E!e~~ ... 
took making the most of every opportunity to .--· 
a new level! Every night I downloaded my 



!tm on the beach 
made the mistake of telling me so! I was quick to take up her 
;'.Sed from the L to A distinction , suitably equipped with we/lies. 

iment 
an extraordinary, subtle beauty to those who explore them. I 

.'ilther and light, that create astonishing images on the shore-
11etimes a matter of minutes and sometimes a few hours. 
11ts create is reflected in this panel. 

images and cleared my cards tor the next day. A good index­
ing system is a real boon - I use /View. Having a laptop with 
me meant that I could see how the work was going. Several 
early nights turned into cosy twosomes with my computer 
and a duvet! 

When I returned to London I thought I might have the mak­
ings of a panel. For my L I had gone to two panel days and 
would really recommend them. However, this time I had 
amazing help from some friends. I printed out the best 
images on proofing paper - a low cost boon - and got all the 
help I could with the selection and the positioning of the 

images within the panel. In the end I had to 
decide for myself and I found the actual put­
ting together of the panel the most challenging 
part. 

I reprinted them, only to have to reprint them 
again when I discovered new dodge and burn 
techniques. I also decided on A4 rather than 

~--'-" A3, and then I kept seeing things I could 
improve on. Mounting board was ordered and 
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then more, when I decided to double mount them. 
Inevitably, there is always an image you are unsure of, and 
spares were printed "in case." I developed an unreasonable 
fear that my Epson 1290 printer would break down. This 
would be a disaster, as I had custom profiles and would not 
have got the same print with a different printer. I used the 
new Fotospeed Platinum Gloss - meant to mimic darkroom 
papers (not that I know!) I had to write a statement of 
intent of a maximum of 150 words. A kind friend advised 
me that there was not much of myself in the first draft. So 
I rewrote it. There was also the hanging plan to prepare, 
which I did on Photoshop with a different layer for each of 
the fifteen images. 

In the end, all was ready and in the box - a huge relief. If I 
was asked for advice, I would say allow yourself plenty of 
time, especially for collating and printing the panel. 
The day went well and I was very pleased to have my panel 
recommended by all five judges. They make a very thorough 
inspection of the panel and the advice is thought provol<ing 
and pertinent. It is really wonderful to see the otl1er 'A' sub­
missions and this time half got through. If you make it your 
name is called, but if you don't you can remain anonymous 
and have another try. One of the panels that day was a re­
submission. There was a really positive atmosphere and 
everyone was very supportive. 

I made an A3 book, contain- .------ ------. 
ing the images and my 
statement. I printed 
straight onto A3 textured 
watercolour paper, using 
Photoshop for the text 
page. Choosing an A3 
hand made card, I had it 
bound with a simple metal 
comb binding at my local 

!"._ __ L __ . -

reprographics shop. You can also buy digital albums that 
have blank paper to print onto. They are very professional 
looking. I have always made books of my projects, ever 
since I was a beginner. They are a manageable way to both 
review and showcase your work. All in all, it was an 
exhausting experience, but one I would recommend to any­
one to whom the idea of an A panel appeals. 



Pictures at an Exhibition 
As John Probert LRPS tells DIGIT: The buzz I got when I walked into my local library a couple of years ago and saw 
the entire gallery area full of more than 40 of my pictures was quite something. And the feeling was 
enhanced by a sign saying: An exhibition of photographic images by John Probert LRPS. So how did he get there? 
John gives us the background here. Incidentally, John has only just bought a digital SLR, and still scans 
from slides. He plans to move gradually to wholly digital capture, but it won't make much difference to the 
end product, which is what the digital revolution made possible for John. You can contact John on: 
j.probert@bluey_onder,co.uk 

I had taken thousands of slides over many years, and knew 
from occasional awards and judges' comments that a few of 
them had potential for display and maybe even com­
mercial value. However I had never come to terms with 
darkrooms, and you know how difficult it used to be to get 
a decent print from a decent slide. So the slides generally 
languished in boxes or occasionally found their way into 
magazines for projection. 

The advent of digital changed all that. I didn't have a digital 
camera then - I've only just bought one - but in 1999 I went 
for a new PC with a hitherto unheard-of amount of RAM, and 
splashed out on an Epson printer, a Nikon slide scanner, 
and, yes, Photoshop 5. 

The next step was to select the slides that might have poten­
tial, scanning them, and seeing what Photoshop had to 
offer. Some of the best ones just needed tweaking in 
Photoshop to optimise colour balance, contrast, etc. Others 
seemed to benefit from selective work - usually as simple 
as enhancing particular colours, or using a filter (Poster 
Edges became a particular favourite) to emphasise certain 
aspects of the image. I couldn't - and still can't - be both­
ered with too much cutting and pasting. I'm afraid my old­
fashioned view remains that if the sky in an image is poor, 
or if the background doesn't suit the subject, then the orig­
inal image probably isn't worth spending more time on. I 
certainly remove blemishes, and I may even admit to remov­
ing the odd waste bin, but that's about as far as it goes. 

"So what sort of pictures 
do you take then?" 

A variP.ty or photographic im.)gcs 
by John Proben I .R.PS 

in 1hc Atrium GsUccy 
Ccntul l.ibracy. U11.bridgc 

SaHtr<IAy 1 - Thursday 20 NovcO\ber 2003 
durlng library opcniog bouC'$ 

Around the middle 
of 2000, I noticed 
that a leisure club 
of which I was a 
member was put­
ting on small art 
displays and I 
approached them 
to see if they might 
show some of my 
photographs. 
Suddenly I was 
faced with filling an 
entire corridor with 
images in about 
two months' time. 
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There seemed to be two obstacles to overcome. The first 
was that if I actually wanted to sell any photographs, I could­
n't use prints from my Epson 1200 and expect them to last 
for any length of time. At that point someone recom­
mended Loxley Colour - send a CD to Glasgow and get fan­
tastic prints on proper photographic paper, by return, which 
magically looked pretty similar to what I'd seen on my mon­
itor. I remain only a very tiny customer of Loxley, so I'm sure 
they won't be aware of how important they were to me. 

The second obstacle was how to avoid spending a fortune 
on framing, and by a stroke of luck I found Rodney Pelham 
in Northwood. 
Looking, with Rodney's advice, at how to frame my images 
taught me a fantastic amount, but looking at how to group 
similar images together taught me even more. I started to 
sense what combination of mount and frame colour com­
plemented each image best. But I had to balance that 
against a need to display similarly themed photographs 
together, which required similar mounting and framing. I 
also discovered how to apply borders in Photoshop, picking 
out an exact colour from the image, creating a thin border 
line, and then a background canvas colour that created the 
visual effect of an inner mount at rather less cost. 

The exhibition duly took place. I sold quite a few pictures, 
but more than anything I proved to myself that not only 
could I take half-decent photographs, but I could also 
display them in a coherent and appealing way. An exhi­
bition at my old school followed, then the one in Uxbridge 
Ii bra ry, then two in a local community theatre and one in a 
local restaurant. It will never make me a living, but it's the 
greatest tun, and I am still trying to find enough time to keep 
it going while making a living! 

Obviously the main benefit I obtained from going digital was 
the ability to have control over my own images, but there 
were so many other advantages too. 

For publicity, I could send low-resolution images to someone 
else, or I could create my own publicity material in 
Photoshop. For my Uxbridge exhibition, the locai press did 
a big spread, and it was supplemented by digital images I'd 
supplied to them. I was even able to create my own busi­
ness card with tiny colourful images on it. 



Even more valuable, though, was the ability to test dis­
play options in Photoshop. By creating mini-versions of 
each image to scale, and then simulating both the final 
mount and frame colour, I was able to try out different 
arrangements without leaving my PC. Here's the layout 
one of the display boards at the Uxbridge exhibition. 
Bringing the two city skylines on the left together was 
quite straightforward, but the four city reflections need­
ed low-key mounts and a silver frame to combine the pow­
erful but different colours of each photograph. 

Of course, with original digital images, you can pretty 
well guarantee repeat quality. So I could dispense with 

How would you like your picture? 
S1cp I: Choose lhe s ize 

(sc.ate I :5) 
~omc- image!> M3)' ttn:tch 1.:, a 13~<:t ~1.tt - ple-»c- uk 

If you wttnt lht print on ils own, to do your own thing, go hl SlCP 4! 
The <.·os1 of th~ J1Tin1 focrea.scs wi1h 1he 5,;.,,e, 

Step 2: Moun! the Print Step 3 : Frame the Print 

Occid-.: whether you like O<.·Cid .. · whclh,.-r you lik<.• 
the cho!:en mounl colour. th .. • chukn ru~m<.· colour. 
Th-.: mou,u co~t i!: fixed. 1h<.· <:0111 of:>. ru~mcd print 
If you don·c wam 11 rran,ed, ii double lh~t of a mounr«:d r,rin1. 
&Oto Step 4, 

Step 4: Order the Photograph 

Take a form. fill in •ll 1ht J¢t~ih, includino .lny .c:pcci.&1 ccc.iuircm..:n1s. 
Han<I to a membtr of the librt\1)' Mall Co home. <.:etehrate. 
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the red spots on sold items and promise to replicate the 
same image, maybe at a different size, maybe with a dif­
ferent mount, frame, etc. To put this across, again I used 
the power of digital processing. I was able to print a 
single display page, on photographic paper, illustrat­
ing the relative sizes of the available images, and simu­
lating the effect that mounting and framing would have 
on both appearance and final cost. 

So whilst some of my final images do take full advantage 

of the digital possibilities, that's not really the point. The 
control the technology gives me is what really matters. I 
now have a portfolio of my available images - it's printed 
six images to an A4 page, with titles. I can show anyone 
an overview of what I can do without carrying a heavy load 
about, and if they like what they see, I can quickly find 
something a little larger to keep them interested. 

What's the one thing I've missed out? The web, of 
course! I don't have my act together there yet at all. My 
pictures have been in various places, but I really do need 
to set myself up with a proper website. Maybe I'll have 
another look at what I can contribute to the RPS site, and 
the Digit site. 

Oh, and by the way, I got my LRPS with digital images on 
CD in 2003. My mentor, the excellent Chris Palmer 
ARPS, persuaded me to replace all my colourful bor­
ders with pencil line borders and simple edges, and of 
course he was right. Imagine how much fun it would have 
been to replace the borders in the conventional way! 

Now for my ARPS ... when I can find the time? 



Getting the Au 
The thrill when that envelope lands on the mat and you d 
name is tremendous. Here Clifford Marsh LRPS explains I 
helped him approach the Licentiate distinction. Cliff tells 
with a Canon 28 / 70 f 2.8 L lens at a number of Amer 
fondness for early American cars. Indeed, his succe: 
dominantly of photographs of these chromium-plated m ( 

-
-~~-.::..__.:. - -

- if'. 1 !11111'1111111111111~111111' f1 
r-, - . . -,r, 

e : -===rmmu===--: ,;::,l 

After a day's shoot of between 200 and 300 photographs, I Channel mixer as I find this to be the very best way to con­
select the images that I wish to retain and discard the vert. I have tried other means but in my opinion it's the best 
remainder. I am then even more selective and choose a few as you have so much control. I then go to Curves for fine tun, 
to be worked on so to speak. The images shown here are ing the tones and possibly a little Contrast tweaking. Then 
just such items. The originals were shot as colour images I would make a selection around the vehicle: this is what 
and then converted in Photoshop - you may have heard of takes the time. Then I paint the background black and 
this piece of software! I then convert to monochrome in that's about it really. 
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,to L plates on 
ron't even have to open it because it has LRPS after your 
~ow his love affair with the gas guzzlers of America's past 
: us that these images were taken on his Canon EOS 100 
1can car shows around the country. He has a particular 
ssful Licentiate distinction panel was made up pre­

rmsters. 

I had been working on my panel for about a year now after 
a couple of senior members at my local camera club - The 
Bedford Camera Club · said that I should give it a go regard· 
ing an L distinction. Up until then it had not crossed my 
mind that my work would be remotely good enough for the 
high standards set by the RPS. 

I went home that night thinking about what they had said. 
Were they right, or would I end up making a complete fool of 
myself? First of all I contacted the RPS and they suggested that 
I attend one of their workshops to see for myself just what 
was required. This I did by attending a meeting in 
Hampshire, and I came away with a better idea, if a little 
apprehensive. I then put together a panel of my favourite 
images· my first toe in the water so to speak. Big mistake! 
Don't make up a panel of images that you like personally, as 
you are not thinking objectively. I found this out the hard 
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way when I took my panel to another workshop, this time in 
Kent,and the judges threw them out, saying I had a third of 
a panel only. That hurt! 

But I have to say these guys were very helpful indeed and 
they suggested that I should concentrate on what I had a 
passion for, as was evidenced in the successful one third of 
my panel. So this is what I concentrated on and worked on 
for the next few months until the day loomed that would be 
do or die. We went up to Stirling in Scotland for the 
Distinction day. I am trying to think of another day when I 
was as nervous: driving test? wedding? And was I glad when 
my name was read out as a successful applicant for the L 
distinction. It has been well worth all the hard work and I 
would like to thank all who have helped and now I am 
looking at the possibility of doing the next step up the 
ladder - the A. 



Dawn Osborn FRPS edits IRIS the Nature 
Group's magazine and was awarded her 
Fellowship for this panel earlier in the 
year. As far as what she did 'digitally' to 
capture the images Dawn explained: 
Well I kept pressing the shutter when I 
had something interesting in front of me. 
The important part is having a good 
knowledge of your subject matter and 
anticipating when to start pressing the 
shutter. The kit isn't so important · we 
all know it is the photographer who 
makes the picture, not Canon or Nikon. 
The images were all processed from RAW 
files in PhotoShop and printed with an 
Epson 1290. Congratulations Dawn. 
Nothing to to it then! 

Ray Wallace Thompson ARPS writes: One 
thing so many people come unstuck over 
is putting in a new sky, especially where 

Snippets fR1 
Got a quick piece of news or a new - or even old - technique which d 

If I receive sufflclent matsdal these sprel!J 

-
there are trees or woolly edges. Below we '-------~-----------------------M offer a reminder of a very simple way of 
doing just that. No doubt members will be able to offer 
many other ways · but keep it simple please. 

Ray also said: Another thing is carrying out sharpening with­
out overdoing it. I usually use this technique for sharpening. 
Copy the picture on to a new layer. On the new layer, select 
Filter>Other>High Pass. 
Use a low radius setting. Then select Overlay for the 
Blending Mode and Merge down. 

How to replace a sky in five easy steps 

First save your original picture safely. 
Select the sky in the picture you want to modify. You can 
use the magic wand or your preferred selection method. 
Advanced users will probably use a layer mask and the 
brush tool. 
Open the image with the new sky. Select the new sky fairly 
roughly · perhaps just by using the Rectangular Marque 
tool. 
Import the new sky into the original image using the Move 
Tool. 
Move the new sky around to match it to your original image. 
You can press Control T and use the box which apperas to 
stretch it if needed. 
Bring up Layers Palette (Press F7) and make the 
Background into a layer on which you can work • just dou­
ble click and press OK and it will be renamed Layer O and 
become active. 
In Layers, move the sky layer beneath the original ( Layer 0). 
Click on Eraser and rub out the selection area to expose 
your new sky. Tidy up and deselect. 
Bear in mind though that you've made a permanent change 
to your image and you won't be able to carry out further 
modifications later. But then you did save the original for 
another try! 
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In response to my question on the Forum about how to put 
snow on text Vincent Lowe ARPS said: I'm all for the easy 
life • why not just download a snow font, such as: 
http:/ /www.dafont.com/ almonte-snow. font 

Ron Sims LRPS suggested this do it yourself technique 
for giving your Christmas greetings a touch of snow. 

This simple system works on any font and is best with 
strong colours against a dark background. Using the text 
tool, write, say, Happy Christmas in the font of choice. 
From the Select menu, Load Selection. Accept the suggest­
ed selection of Happy Christmas Transparency. This will 
(should) give an exact selection of your lettering. Now Save 
that selection· Select>Save Selection. I call it Text. 
Delete the type layer in the layers palette. You will still have 
the lettering selection on the image. Fill this with the 
colour of choice. Using the freehand lasso set to Subtract 
from Selection, delete the lower half of the now filled selec­
tion making the top line jagged and wiggly (lovely word!), In 
the selection menu open Modify Selection and expand by 
two or three pixels. This depends on the image resolution 
you are using, could be more at high resolutions. Now just 
fill the selection with white. It takes a lot less time and 
effort to do than to explain! As a slight improvement, after 
filling with white, Edit>Copy/Edit>Paste the "snow" over 
the original then you can add effects to the "snow". A very 
light Bevel and Emboss gives a nice shape to the snow. 

And Maureen Albright ARPS suggested this little bit of fun 
if you want a message in snow. Go to: 
http://www.star28.net/snow.html and type in your name. 
It takes about one minute so just be patient· it's worth it! 



tm members 
dher members would find useful? Why not pass It on through DIGIT? 

rds could become a regular. It's up to you. 

Flying the Eagles, Owls and Hawks with ran Skelly LRPS 
Ian has been puting up some shots of of an American Bald 
Eagle on the Folio, including showing her blinking using her 
nictitating membrane· well, that's one you'll have to follow 
up with Ian on his website at: www.skelly.eu 
Meantime, here she is on the right and as Ian says: One 
seriously large bird. 

Above is Ian's Touchdown, a four image composite of an Owl 
landing. He's trying to build a sequence like this with 
hawks although this bird is a LOT slower. Not surprisingly, the 
project is taking a little time to come to fruition. Ian already 
has plenty of individual bird pictures but usable sequences 
- well, no doubt we'll be seeing those soon. 

Calling all Mac users 
Tony Poole ARPS has just been given an Apple Mac - yes, given, 
he assures us! He's busy seeking advice from some of our res­
ident Mac users -Bill Henley LRPS and Tony Healy ARPS are two 
for starters. But just how many IVlac users are there are out 
there? And would there be sufficient interest for Mac-specific 
meetings? Contact Bill at: wehenley@mac.com 
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Winners All! 

Mike Brown ARPS was the winner of the /LEX Press book prize for the most lnnovatl'le use of dig/ta/ Imaging In a print displayed 
at the members' exhibition at D-Day Rugby on 29 October 2006. Mike gives the background to his photograph and we have a 
comment from another member. Mike's prize was The Book of Digital Photography reviewed In the last Issue. He told DIGIT: I've 
now had a chance to look at the book by Chris George and am certainly Impressed. It Is well written and well Illustrated. 
It Is comprehensive and up-to-date and these days that's saying something. I see that he has numerous stock Images on Alamy. 
It was an appropriate prize - thanks /LEXI As for his winning Image Mike says: You have a perception and Photoshop usually has 
enough tools for you to achieve It Experimenting with changes can sometimes leadtberllancementstbyourperceptlons. 

When Mike's images was seen on the website Glen lrven LRPS 
echoed the selectors· thoughts precisely when he commented: It 
reminds me of old comic books as a kid. He went on to say: 
Amazing detail and time spent. Unique style, some great stuff on 
your site too. This sort of work really shows some great talent and 
skill. It's not often I get this excited over people's work, but this 
has made my day. Isn't that what its all about! 

So, how did Mike conceive and execute this prize-winning image? 
He told DIGIT the story. 

The Tall Ship Race was about to arrive as our coach deposited us 
by the magnificent Sage building in Gateshead. We were confront-

~-----------, ed by this view as we 
emerged from the other 
side of the building. 
Bustling crowds had 
already assembled and 
the scene was vibrant. 
The spectacle had an 
immediate appeal, even in 
the absence of any tall 
ships, I could not resist 
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taking this handheld shot on my 8 Megapixel Nikon 8800 
camera. 

The settings were: 1/300 sec; F4.4; vibration reduction on; 
Exposure compensation +0.3EV; multi-pattern metering; JPEG 
Extra quality. Comparison of A3 prints has suggested to me that 
for this type of shot no significant advantages are gained by the 
use of RAW format rather than Extra, the best of the four JPEG set­
tings on this camera. I do use RAW when called for, by contrasty 
light conditions for example, but JPEG leads to simpler and faster 
processing and the format is universal. 

Whilst viewing the day's images on my monitor at home, I had a 
perception of how this image could look, but the question was how 
to match the perception. Whilst there are many Photoshop-com­
patible filters and add-ons that produce particular overall effects. 
t~1is perception called for a lot of detailed work, which differed for 
the various parts of the image. It would be impractical to go into 
the minutiae of all the changes made, but the main ones are 
described below. The objective was to create an impressionistic­
looking picture, and to do so without losing fine detail, which 
seemed to be an important feature. 



When manipulating photographs I 
tend not to be bound by convention, 
and so would not advocate for gener· 
al use the manipulations described 
below. Add-ons can certainly be 
beneficial and effective, but in this 
case I didn't use any. It's more sat­
isfying to match one's subjective 
perceptions using straightforward 
tools, if possible, than to apply over· 
all effects using an add-on software. 
It might be worth mentioning that I 

have an Epson R1800 printer that uses 8 inks, and has a wide 
gamut. When checking that colours are within gamut there is 
a special setting in Photoshop for this printer 
(view>proof set-up>custom>Stylus Photo R1800). 
Using some of the other settings, the gamut warnings will 
be too restrictive and, had they been used, some of the colours 
in this image would have registered as being over-saturated. 

First I cropped a slice off the bottom. Then, lamenting the porridge 
sky of the original I experimented with various changes. 
Eventually I selected the sky, inverted it, and adjusted it using 
lmage>Adjustments>Shadow/Highlight. The reflecting water 
then needed adjustments to correspond with the sky. 

Individual components of the image were selected and made 
to look more vibrant, as they would have don in better light· 
ing conditions. This required the use of standard colour and 
brightness controls. A less standard process that followed was 
to outline various items: note particularly the people on the 
bridge. I felt that they were an important part of the image 
and I liked the effect of outlining. To achieve this, a selected 
part of the image was copied into a new layer. The outlines 
were formed using Filter>Stylise>Glowing edges. The edge 
width was minimised in order to preserve fine detail using 
the slider in the box of controls accompanying the filter. 
When applying this filter the image turns black, except for the 
glowing edges. The black areas were removed using first 
Select>Colour range and then Edit>Clear, leaving only the 
edges visible and the rest of the layer transparent.. 

Apart from that it was mainly a matter of attention to detail. 
Note for example the white flagpole in the middle. In the 
manipulated image it almost disappeared against the bright 
water so I changed the bottom half to black. Ihe colours of 
the tiny flags in the bunting were changed according to taste. 
Now have fun with one of your images and satisfy your 
artistic aspirations! Mike's website is: 
http:/ /www.hg29hh.freeserve.co.uk/NewcastleRiverside.htm 

In conjunction with ILEX DIGIT ran a second competition 
with two prizes of Chris George's book for the best image by a 
member under 40, and the best black and white image. To 
be frank, the number of entries was disappointingly low but 
fortunately the quality was high. I am not really sure why 
the competition did not appeal so I would be interested to 
hear from members whether more would be welcomed, and 
if so in what format. Ihe two winners from this competition 
are opposite. More Pictures on page 30. 
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Glen's under the magic age and chose monochrome for Soul 
Mate, explaining: I love close up lifestyle shots with loads of 
subject expression. Taken with a flash and two slaves and con­
verted to B&W. Given a studio look and feel. 

Ian's meter was fooled by the pure white sand of a New Zealand 
beach and under-exposed but even so detail was lost in the 
sand. Converted to mono using Channel Mixer and Noise added 
for grittyness. Printed on Hanemeule Torchon paper. 

, · 
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D-DAYRUGBY 
In a change of format this year's annual event for the Digital Imaging Group -styled 0-DAY Rugby -saw both mem­
bers and non-members gather at the familiar Benn Hall, Rugby on Sunday 29 October but with just one major pre­
senter, John Henshall FRPS, and fewer trade displays. This pictorial report will give you a flavour of the day. We 
really do not have the resources to mount such a large event ourselves each year and so for 2007 the com­
mittee will be exploring alternative themes as suggested by your responses to the survey in 2005. We will be look­
ing at ideas such as smaller, residential weekends with several expert tutors to provide a one-to-one learning 
environment - with lots of fun and good food too - see the Stop Press on page 2. And repeating the one-day work­
shop which proved popular earlier this year. So, please let us have your views. 

Glenys Taylor ARPS and Peter Roberts ARPS book in delegates 

In one of the biggest turnouts in recent years 400 delegates -
about a third of whom were not yet Society members - came to 
Rugby for the DI Group's annual event. The RPS 
Digital Day was sold out. This year John Hen­
shall FRPS lead the day, with able assistance 
from colleagues such as Alan Capel, Head of 
Content at Alamy who explained the stock library 
market and showed how easy it was now to sub­
mit and perhaps earn some financial reward, 
and John's neighbour photographer Jay Myrdal. 
We also had, thanks to John's persuasive pow­
ers, the first UK showing of HP's Z2100 Photo 
Printer 

Trade support was excellent in the limited space 
we had for their products this year and members 
enjoyed talking to Fotospeed, Permajet, Sigma 

Alex Dufty LRPS, John Long ARPS and Ron Morgan LRPS 
receive the prints for the members' exhibition 
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(who brought along their brand new SD14 announced at Photok­
ina with a 14 Mega pixel Foveon X3 sensor), On Line Paper, l<.ata 
ca mer a bags, Explore Digital and Just Ltd lens clean­
ing solutions. 
They all provided 
valuable products 
for the prize draw -
always a popular 
event at these 
days - especially 
when a year's 
membership of the 
Society was on 
offer - along with 
Nikon and Canon 
equipment. 

I wish we had a bigger table! Ray Grace 
LRPS sets out the Fotospeed stall 

Early preparations. Chris Burs/em of On Line Paper 
ensures he has plenty of supplies for the day 

John had arranged for 
Hewlett-Packard Espanola to 
have an HP Designjet 
Z2100 Photo 24-inch 
printer at the day and he 
showed not only his own 
prints but was able to 
make prints from dele­
gates' files on the day to re­
ally test and demonstrate 
the printer's capabilities. 

John Henshall FRPS 
in action 



Huge prints from the new HP Z2100 machine 
come under close scrutiny 
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John enthused: The Hewlett Packard Z-series printers are 
fantastic products. They will be available in both 24-inch and 
44-inch wide versions with either 8 or 12 inks. HP has made 

calibration and the production of ICC 
prof ii es a hands-off 'no-bra ine r', he said. 
They may be a trifle big for most of our back 
bedrooms but the prints certainly attracted 
lots of attention. 

Checking out the members' exhibition 



An instant print exhibition by members is an ,--------:irr."'!'-:aa 

established part of the event and this 
year the entry was so strong that we 
nearly ran out of screens on which to 
display the prints. First prize and a 
£50 cheque went to Rick Alexander 
(above right) with his exquisite print. 
Iris Hall of the Fairy Queen. 

Yes, we've got that paper here in A3. Customers at Permajet's stand 

Mike Brown ARPS seen here ,rn-.__ 
with Exhibition Organiser Alex 
Dufty LRPS took the ILEX book 
prize for the most innovative use 
of digital imaging- see page 21 
for the full story. 

We were delighted that 
President, Professor Ralph 
Jacobson FRPS was with us for 
the day. He presented several 
distinction awards including a 
Fellowship to DI Group member Charles Frewin FRPS. 

Digital photography now offers us all an 
easy opportunity to submit to stock 
photography libraries and Alan Capel, 
Head of Content at Alamy, explained _ _.._...._._ 
that his UK-based company gave photographers 65% of the rev­
enue from each sale. With 8000 contributors there are now 7 
million images on the website www.alamy.com. 

John Henshall FRPS on his website www.chipshoponline.com 
complimented the committee, saying: Organising this day took 
an enormous amount of effort. My grateful thanks to everyone 
who worked hard to make it possible, and to the 400 delegates 
who attended. 

Bob Moore FRPS demonstrates Permajet's 
continuous ink flow system 
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I've brought a few lenses says Ray Fitchett of Sigma Imaging UK. 
I borrowed a Sigma 10-20 mm Jens for this shot! 

John Henshall FRPS answers the questions of delegates 
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We had no less than 32 prizes spon­
sored by generous photographic suppli­
ers and so all the delegates had a good 
chance of taking away a something 
ranging from a sensor cleaning kit to a 
Barrie Thomas tutorial CD. Terry White 
ARPS was lucky enough to take home a 
Canon Pixma A3+ printer. 

When Clive Haynes FRPS came to 
thank an enormous list of people at the end of the symposium, 
along with our main presenter John Henshall FRPS and the trade 
exhibitors and those who contributed valuable prizes for the draw, 
he had some special words for two lovely, hard-working ladies. 
Both Hilary Roberts and Glenys Taylor ARPS are standing down 
after more years than they care to remember on the committee. 
Hilary has been the prime mover in the DI Group's annual major 
event , and our secretary Glenys has ably held things together 
through thick and thin since being a founder member a decade 
ago. We are all very indebted to them. 

Clive Haynes FRPS wrapping it up at the end of a long day 

And finally ... 
Excited about the possibility of selling images 
to a stock library but puzzled about how to get 
that uncompressed 48MB image that they de­
mand? It's really very simple, says John Henshall 
FRPS. Your photograph needs to be something like 
3400 x 5100 pixels for example but no sensor 
available to ordinary mortals will produce an image 
of that size. So, just use the best resolution you've 
got and 'res up'. that is, Resize (using lmage>Re­
size) selecting Bicubic Smoother or perhaps Bicu­
bic Sharper whichever gives the best result. Easy 
really. Good luck! 

My thanks to David Naylor LRPS for his 
excellent help with the photo coverage. 



THE GREAT GALAPAGOS EXPEDITION 
About a year ago Martin Elder ARPS saw an advert in the Royal Photographic Society's magazine inviting 13 
other photographers to join Dr Cella Mannings ARPS on a 10 day trip to the Galapagos Islands for a photo­
g·raphic expedition. Celia had been to the Galapagos the previous year and was so enthralled with what she 
saw and photographed that she decided that another visit had to be undertaken. She felt sure that other pho­
tographers would be interested and so advertised for a likely bunch. Soon she had her possible future travel­
ling companions lined up, with different backgrounds and styles but all with the interest of going to the 
Galapagos Islands with Celia, aptly designated Group leader against her wishes. 

This was of great interest to me for the Galapagos Islands had 
been on my wish list of places in the world to visit for some time 
and here was that chance with the added bonus of meeting and 
living with 13 other photographers for ten days of picture taking 
and cruising in a motorised yacht, something I had never done 
before. 

In passing, such a trip did not appeal to Margaret my wife when 
she considered the long flight to Ecuador/Galapagos and then 
the living for ten days in close contact with photographer nuts on 
a bobbing boat, the Samba, 78ft by 19ft in size. This was a jour­
ney too far for her, so Go she said - Go, just go. But where are 
the insurance policies? 

The group met for the first time at Heathrow airport on 3 July 
when we then travelled to Madrid and onto Ecuador. After staying 
overnight in the capital Quito, we then flew to Baltra, the 
international airport on the Galapagos, where $100 USA per per­
son is charged to be allowed to land and stay on the islands. By 
now it had been established that the equipment held within the 
group ranged from professional type cameras with huge lenses 
and large tripods, through the range to include compact cam­
eras. Digital and film cameras were included. With such variety, 
much technical talk, experience transfer, work assessment and 
light hearted banter existed throughout the trip. Also, in passing, 
with five medical doctors within the photographic group, any 
risk assessment pointed to greater survival for previous non­
sailors in relation to the next ten days island hopping about on a 
small boat. 
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The Galapagos consists of 13 main islands, six smaller ones and 
well over 100 islets and rocks scattered over an area of 430 sq 
kms of ocean right on the Equator and are located 
some 1000km to the west of the South American coastline of 

Ecuador. These islands are a strange, strange mix of animals and 
birds with strange habitats, strange vegetation, at times not par­
ticularly colourful but very wonderful in mystery. Volcanic and 
extremely rugged in places, the routes travelled throughout the 
trip offered great natural history photography, many beautiful 
beaches, mangrove shorelines and land-locked lagoons. 

The weather varied from a bit fresh first thing in the morning to 
quite high temperatures some days demanding the application of 
high factor sun creams and headgear shade. Wet sea landings 
could be lovely and warm on the feet and legs, yet swimming in 
the sea for any length of time demanded the wearing of wet gear, 
especially if snorkelling. Not what one initially expected when 
located in the Pacific Ocean, right on the Equator and in July, 

The daily programme was up every day at 0500 hrs, with a Good 
Morning, Good Morning call from a cheery guide, breakfast and 
into the rubber dinghy for 0600 hrs, wearing lifejackets and hug­
ging equipment bags of various sizes and off to face wet or dry 
landings on different islands each day, Whilst onshore, the morn­
ing photographic session lasted for about five hours getting back 
to the Samba for coffee. Some then took up the opportunity for an 
hour to snorkel and try underwater photography whilst others 
transferred their morning shoot into laptops or portable hard 
drive storage before breaking for lunch, the meal often being 
taken whilst cruising between island locations. Then for the after­
noon session, back onto the islands, for about another four hours 
picture taking. The transfer dinghy was then called up and the 
group ferried back on board the Samba for showers, drinks and 
evening meal. Encounters of the day were exchanged throughout 
before being off to bed by 2200 hrs. The food was superb, much 
international variety and cooked to perfection by the chef and 
his mate in the boat's small galley. 



The Samba would often sail during the night to new island 
destinations and several times very rough water was encountered, 
but the sickness pills issued to us worked well along with fer­
vent prayers for survival by the lesser experienced sailors. One 
rapidly learned to believe in such stormy times that as the 
Captain had not issued any call for life jackets to be worn, or 
abandon ship, we were going to survive. 

Several different light conditions were experienced: beautiful soft 
light in the early mornings gradually gave way to harsher light as 
the morning progressed, then reducing in the afternoons and 
finishing the day with often a gentle warmth in the evenings. 

Throughout the tour a Galapagos Authority qualified natura I ist 
guide was always in charge of the group, endeavouring every day 
to present to the photographers the type of subject matter they 
desired and describing the flora and fauna in excellent detail. The 
guide did however demand from the group a fairly strict obser­
vance of the tourist/environmental code imposed by the 
Galapagos Authority designed to protect the flora and fauna 
throughout the islands. Where feet were allowed to tread dur­
ing the excursions was clearly delineated by path marking and 
specific locations marked out of bounds. This control seemed 
very necessary as animals and bird life appeared everywhere and 
refused to move just because humans wanted to take pictures, 
Breeding grounds for example whilst visually exposed to people 
could easily be destroyed by careless feet attached to bodies 
engrossed in the seeking out of the best picture-taking angles and 
probably each member of the group at least once received a gen­
tle reprimand from the guide when about to make the wrong 
choice of 
position. 

The personal experience of shooting digitally was enjoyed 
immensely as one could assess the results of shots immediately, 
allowing retake if necessary before moving on. Surplus shots 
taken in sequential mode when photographing birds in motion for 
example could be discarded when found to have missed the sub­
ject partly or completely, whilst the selection of best was easily 
transferred and readily saved in storage freeing the cards for the 
next day's shoot. This facility gave the added bonus of easy visu­
al assessment and comparison round the table of each group 
member's work whilst the sites visited and our experiences 
were still very much in mind a few hours later. 

Elsewhere the flora and fauna of the Galapagos is presented and 
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catalogued in detail with recent BBC film programmes showing 
the splendour of the islands in huge detail, so this tale finishes 
with the fact that 14 people enjoyed immensely the Galapagos 
Islands, the experience of small boat cruising, great friendship 
and skills transfer - and the fact that we all returned. 
Many thanks to Celia Mannings for organising the trip and the oth­
ers for their participation. 

Exhibition News 
DI Group Exhibition closes on high for 2006 

After successful showings in Swansea. Swindon, Oldbury and 
Bath the 2006 DI Group print exhibition came to Weybridge in 
Surrey for the first time. With publicity in the local papers and 
camera clubs it attracted both members and those new to digital 
imaging. Tremendous! and Brilliant' were the usual comments 
from visitors. 

Alex Dufty LRPS, the 
Exhibitions Organiser, 
is now planning for 
2007 so see the spe­
cial insert for the entry 
form. We want you to 
help us this year and 
reduce the workload 
for the committee by 
adhering to the 
instructions for sub­
mission and the for­
mats and sizes. See 
page 31 for all the 
details on formats and 
please read the guid­
ance on the insert in 
this magazine carefully. 

,------

This year's exhibition is Bert Crawshaw ARPS and John Sparks 
now being made avail- LRPS help put up some of the prints 

able as a CD with a 
commentary on each image by Chairman Clive Haynes FRPS. 

We hope to have it ready early in the new year and, for a 
modest cost to cover production and postage. it should prove 
an entertaining and instructive session at your local meeting or 
even at home. 



~--------. Bill Henley LRPS has been travelling in Africa again and recounts some of his adventures and how 
Africa Lives he protected his digital equipment whilst in Gabon. For this panorama Bill used the controls within 

Aperture to ensure that the three images had the same colour tone and quality. Accessing Photoshop 
via Aperture he made a composite panorama, printing on 3x1 ft canvas. Bill is looking forward to his 
next Africa Lives exhibition and a return visit to Gabon in 2007. Visit: www.afrlcallves.org 

My camera was resting secure inside a 
dry bag in my day sack with the tropical 

L...-______ ......, rain penetrating the humid, thick jungle. 
Surprisingly cool drops of water were running steadily down my 
neck. The heavily built African guide moved softly a few steps 
ahead of me in the midday darkness, stopped suddenly and 
gesturing discreetly, gradually backed towards me. He had quite 
literally bumped into an elephant that stood silent, grey and invisi­
ble amongst the vine covered trees. Soon my camera was out of 
the bag and while the nervous guide ushered me in reverse I tried 
for a photograph. I did not carry flash, and anyway using one was 
obviously out of the question as it might well provoke the elephant 
to attack. I quickly set the camera speed to ISO 3200 and grabbed 
a couple off rames. However, with the light so low, even the image 
stabilisation could not compensate sufficiently for camera shake 
and the result was a large dark blur amongst equally blurry trees. 
After a prudent detour during which had to circle round two more 
elephants that were sheltering from the torrential downpour, we 
emerged from the jungle onto the grassy verge that led down to the 
surf-battered sandy Atlantic beach. The rain stopped almost imme­
diately and we walked in a line under a grey sky to a rough low log 
table that was beside a crude string hammock strung leisurely 
between two palm trees. After eating a packed lunch the guide, the 
driver of the boat and another young African man, who had come 
along for the ride, made themselves comfortable and went to sleep 
for an hour. I occupied myself tal(ing photographs of the sleeping 
bodies, the tropical coastline and the distant grazing buffalo. I 
switched between my 35-lOOmm zoom and my 70-300mm zoom. 
With some light rain in the sticky air I still needed to shield my cam­
era and lenses. Once again the strong sealable impermeable sacks 
proved invaluable as they did when moving between the outside 
tropical conditions and cool air-conditioned rooms. 
Just as my African guides stirred I spotted an elephant moving away 
from the distant buffalo and following the sandy shoreline as he 
ambled gently towards us. With undignified haste I retrieved my 
camera from within the day bag, switched to my telephoto and posi­
tioned myself at the edge of the sea. The elephant continued to 
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approach us and I was able to fire off a series of shots as he walked 
by us, looked squarely at us in a menacing manner and then dis­
solved magically into the jungle behind him. It was then that I 
realised that as I had struggled to quickly remove my camera from 
within the dry bag, I had accidentally turned the thumbwheel on the 
camera. It had been set to RAW together with smallest jpeg and an 
ISO 200. Fortunately the new accidental setting was fully automatic. 
The downside was that it defaulted to just the maximum size jpeg 
and lost the RAW setting. The upside was that the ISO setting was 
automatic. 
I had failed to realise how dark it had become with the dark cloud 
and falling rain. The automatic ISO function fortunately wound up 
the ISO and I had got my pictures. It would have been good to have 
had RAW images on which to work but it was better to have jpeg 
images that were correctly exposed without too much movement. 
Our boat was moored back in the lagoon and on the other side of 
a strip of thick primeval forest. To return we had to wade precari­
ously through the sea in order to skirt the jungle and avoid the pos­
sibility of meeting more elephant on the narrow jungle paths. Up to 
our waist in the waves and dodging the dangerous tree trunks that 
were being thrown at us by the surf it was reassuring to know that 
my photographic equipment should still be safe buffered by spare 
clothing and sealed from the sea. 



Back at the Casse de Passage the generator was not operating and 
there was no electricity. I was given a hurricane lantern and this in 
addition to light gave me a gentle heat to warm my camera and 
lenses. Despite my precautions the rain had made everything damp 
and I was very concerned that the 
electronics would fail. Placing them around the oil lamp and rotat­
ing them every ten minutes did quite an effective job of drying 
them. My only other companion was staying in the room next to 
mine. He was a Swiss doctor who had met a Gabonese girl at the 
Albert Schweitzer hospital and had now come to her home village 
to be with her for few days. He had brought some bags of silica gel 
and would heat them in a butane gas oven before placing them in 
his camera bag. This was a very effective way of drying things out. 
I had four 2GB compact flash cards but when away for some days 
it was necessary to back up my images to a battery powered hard 
disk. The main concern then was to conserve the battery power of 
my backup disk. As I had four camera batteries I was not worried 
about lacking power. I expected to be able to take at least 6GB of 
images with each battery. In my kit there was a mains charger with 
a continental socket adaptor and I had a charger for the cigar lighter 
socket in a car. However, neither of these was of any use when I 
was a two hours' speedboat ride away from any mains power or 
road vehicles. Any inconveniences were fully compensated by 
being in a thin strip of trees between an endless stretch of tropical 
sand and a lagoon inhabited by crocodiles and hippos. 
My excursions into town were for just an hour or two at a time and 
I was therefore able to carry plenty of memory and power for the 
time needed. Back at my base outside town I had mains power, air 
conditioning and access to a laptop computer with external hard 
disks. There was also a vacuum cleaner and with the fine nozzle 
this proved extremely useful for both ensuring that the lens mecha­
nisms were both dry and free from grit. The latter proved to be the 
most difficult problem encountered as the dry dirt roads sent up 
clouds of dust that found their way into the zoom lenses and 
caused them to grate noisily when twisted. It took many sessions 
with the vacuum cleaner to obtain free rotation. It was also neces­
sary to try to avoid changing lenses in such conditions. I did carry 
a sensor cleaning kit but preferred to avoid any spots of dust if pos­
sible. 
The compact 70-300mm Diffractive Optics zoom that I carried was 
convenient even if not as high optical quality as my standard tele­
photo. I had thought that a telephoto would be used a lot when 
taking photos of the local population. The local wisdom was that 
the Gabonese people did not allow their photograph to be taken 
and during my initial accompanied forays along the main streets my 
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camera was used very discreetly. However, over a period of weeks 
I met some African WWF and Smithsonian Institute workers, local 
plantation families and some of the local secondary school pupils. 
In the final weel{S of my stay I walked alone around the town with 
my 35-100mm lens set on wide angle and taking intimate pictures 
of the population. The bright tropical sunlight allowed a low ISO set­
ting although the extremes between highlights and shadows would 
need anention at a later stage. I relied on the 12.8 Megapixel 
image to allow room for cropping whilst leaving sufficient resolution 
for large high quality prints. It also meant that the 300mm lens 
could be cropped to give me an equivalent 450mm or longer lens. 
When I returned to the UK I left a copy of all my images in Gabon 
and carried home a hard disk with my copies. Only when I had 
checked that all was in order and had backed up my files in at least 
two places did I email Gabon to say that my images there could be 
deleted. 
I buried my camera kit in my small rucksack. I lil{e to be able to 
carry my bag on my bacl{ when wheeling my case and I do not want 
it to be obvious that I am carrying expensive items. 
With some thousands of images I needed to have a way of organ­
ising them that would permit me to search and select quickly. I 
imported them into the Aperture program and automatically 
archived them to a separate hard disk. I then set up a basic set of 
keywords that would enable me to search by the main categories 
eg Wildlife, Local People, Landscape. These were allocated to but­
tons and keys and it was a quick job to select whole batches of 
images to any category and assign a keyword. It was then possible 
to produce keywords for sub categories and to repeat the process. 
Similarly if I were selecting images for an exhibition or a DVD I would 
add a keyword to the selected images to identify them as such. 
Then by setting up smart albums I was able to have. for instance, 
all exhibition images automatically appear in the exhibition smart 
album. It was then very easy to work on these images and even to 
automatically publish them to a DVD, website or book. For each an 
export preset was defined and this could be selected at the time of 
export. For example, a preset could define the printer, the type of 
paper, resolution, size, and any colour corrections or colour profile. 
Adjustments for exposure, straightening, cropping, colour etc are 
carried out within Aperture using the built in adjustment controls 
but without altering the RAW (master) image. Of particular value 
with the tropical light is the highlight and shadow control. When 
desired an image may be manipulated in Photoshop whilst still 
being managed within Aperture. This has proved very useful when 
producing images suitable for large canvasses. 
Visit www.africaLives.org for more of Bill's photographs. 



A Wann Welcome to 
Yorkshire 

After a lot of spade work from Terry 

DIGITAL FACTOIDS from Carole Hewer ARPS 
Digital terminology and related jargon in 'byte' sized chunks! 

White ARPS amongst others we ALIASING In a digital image, the appearance of jagged 
can now introduce the new ·staircase· effects along lines and edges, especially diagonal 
Yorkshire team. Robert Croft LRPS lines. Aliasing is accentuated when the pixels in the image are 
is the DIGRO, John Stringer LRPS highly enlarged and visible to the viewer. 
the Secretary, George Hodlin BITMAP An image made up of rows and columns of pixels, also 
ARPS looks after money with called a raster image. Each pixel represents a spot of solid 
Norma Phillips LRPS and Dave colour. 
Burgess LRPS making up the rest CALIBRA·noN The act of adjusting the brightness and colours of 
of the committee. one device, such as a monitor, to match those of another, such 

Robert, the Yorkshire Region Digital Imaging Group Organiser to 
give him his full title, joined The Royal Photographic Society in 
2003, gained his LRPS in that same year. After all the hard 
preparatory work he's proud to have the opportunity to start 
planning and organising lectures and meetings in the Yorkshire 
Region. 

Robert has been interested in photography since the age of 11 
with his first Kodak Brownie, Later he bought a Yashica SLR and 
his enthusiasm developed tremendously. His first club was the 
Co-op Camera Club in Barnsley until he moved to Selby where the 
Selby Camera Club boasts over 50 members and friends. 
Contact Robert on: 
01977 685262 or Robert@robertcroft.wanadoo.co.uk The 
website is: http:/ /yorksh ire-digi. mysite.orange.co.uk/ 

Inaugural meeting Sunday 4 February 2007 
Selby Community Centre, Scott Road. Selby Y08 4BL. Ample car 
parking. Coffee.Tea & Biscuits available 10 am Meeting starts at 
10.30 am. After the welcome there will be a show of successful 
ARPS prints by George Holding ARPS, followed by a loot< at Spurn 
Point through the viewfinder of Marjorie & Tony Furmston FRPS. 
Lunch is at 12.30 pm so bring a packed Lunch. 
At 1.30 pm Look at it our way, a talk and demonstration using 
Photoshop with Majorie & Tony. Meeting closes 3.45 pm. 
Tickets £5 to RPS DI Group members, £6 otherwise. 

Next meeting planned for Sunday 13 May 2007. 

Cruise Ship in the John Hopkins Inlet of Glacier Bay, Alaska 
by Bert Housley ARPS 

as a printer. Calibration may also be used to simply adjust a 
device to some standard of performance. 
PIXEL Means picture element (shorthand 'pix el') The smallest 
visible component of a digitised image. The basic dot that 
contains a single colour 
PLUG~N A small specialised software program that is opened 
and operated by image-editing software and closed when its task 
is finished. Plugins may be manufactured by companies 
unconnected with the manufacturer of the imaging software. 
RGB Red, green and blue, the primary additive colours of photography 
and digital imaging. Computer monitors create images using the 
RGB colours. 

Blue Heron on the shore of the Gulf of Mexico, USA 
by Mike Booth ARPS. 

Moon Children by 
Shirley Britton ARPS 
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A Dlgltal Production 

You've probably never wondered what happens next when you email me or put a CD in the post with an article and some pictures 
for DIGIT. Just pop it in the magazine and send it to the printers? Well, it's a tiny bit more than that so here's a quick look at the 
production process. The magazine has now settled into a quarterly publication of 32 full colour pages reaching members 
in December/January (with the AGM and Exhibition entry flyers), March, June (AGM report and all the selected Exhibition prints) and 
September (this year including the D-Day Rugby details and ticket application). To ensure sufficient spares for new members and 
promotional purposes after distributing to 1045 (including 55 overseas) members and 30 to the Society, I print about 1400. As 
well as the actual print costs we have postage of £600, and the cost of envelopes and inserts. You can guess that DIGIT takes the 
lion's share of your £12 subscription! 

Contributions from members are the mainstay, some volunteered. some cajoled into writing. Some committee members have been 
tremendous in their support by providing articles, and there are a couple of people outside the committee on whom I can always 
re!y. The format now is to include a distinction panel or two, a How To tutorial if possible, a book review, a special technique from 
a member and occasionally an interview, as well as reports of our meetings. We are still, I believe, the only special interest magazine 
to use the Society corporate style - including this type face. 

So, how can you help when you submit your masterpiece for publication? Please include some words saying how you did it - that's 
what most members want to learn. Give me a few hundred or a few thousand words, and leave the editing to me. Tell us about a 
particular technique or experience. Use something like Word or rich text format (rtf) that can be easily read by most software. It 
helps if you spell check first! For the detail of the pictures see the box below for the formats for the images on CD that accompany 
your annual exhibition entries, and for DIGIT. Make sure the references to images in the text (and for the exhibition print titles) actually 
match what's on the CD. If you do this you save me (and Alex Dufty for the exhibition) a lot of time and heartache sorting out what 
you might have meant! In simple terms, for publication use a resolution of 300 ppi and for the exhibition CD use an image size of 
500 pixels on the longer side. 

To lay out the magazine I now use QuarkXPress, working with a local 
printer Tram at of Hersh am in Surrey who have given me a lot of help. 
Tramat are a friendly, family firm and will, of course, be happy to 
quote for any printing needs from brochures to posters. When I've 
done a rough layout I start to get into the detail. When you've taken 
the trouble with your writing and your best photography I want to do 
my best to show it off to advantage. That means some editing to 
make it all fit on the double page spreads, and placing the images 

- as well as deciding what to leave out. 

That process takes a couple of weeks of ,....,,..___,,.,,--==-==------:-:,..,.,...-----==-....,,....,.,...--.,,.,,.,..-,----. 
mulling over possible layouts, Then it's a 
trip to Tramat for a first discussion with .__ ________ ...:...._ __ ....:....__....:::_ _____ __, 
Tony, a photographer himself, who carefully checks my amateur efforts and makes 'suggestions'! He runs off 
single colour proofs for checking which I go through to find all the mistakes I've made. Then a full colour proof 
to assess the colour balance and round the loop we go again until we hope we·ve got it right. As the print 
deadline looms we fix the magazine and a couple of weeks later the production run is complete. When the 
printed A2 sized paper is dry, it is folded into 8 page sections, then each of the 4 sections are stitched 
together to make 32 pages, put in the envelopes with any inserts and, with the overseas airmail separated 
out, taken to the Post Office - hopefully to reach you early in the New Year. Pretty straightforward really. 

Size Isn't everything! Getting It right for the Exhibition CD and DIGIT 
Want to see your exhibition entry printed in the summer DIGIT which fonns the exhibition catalogue? Want to submit an 
articlle with images to DIGIT? Want to help the Exhibition Organiser and the Editor? Then read on. 
First the exhibition. To allow accurate and consistent reproduction in DIGIT and ease of loading to the website, please in­
clude a CD of the images with your entry. Write your name on the disk but don't include any other material on the disk. 
The images should be BOTH: 

• TIFF at 300 ppi, sized about 15 cm x 10 cm (6 in x 4 in). Please convert this file to CMYK using conversion Euroscale Coated v2. 
In Photoshop first go to Edit>Color Settings and in Working Spaces set CMYK to Euroscale Coated v2; then 
lmage>Mode>CMYK Color; then Save As and select TIFF as the format; and 
• JPEG sized no more than 500 pixels on the longer side with a maximum file size of 95 KB. 

Remember that the titles of the images on disk must be exactly those of the prints to allow us to identify the selected one. 
Mac users please ensure your files are PC-compatible. 
Second, for articles to be printed in DIGIT, I need just the TIFFs please as described above. 
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The Intellectual property rtghts of all material In DIGIT remain with the authors 

Chair: Clive Haynes FRPS 
01905 356405 

chairman@digit.org uk 

Secretary: Glenys Taylor ARPS 
01823 282516 or 01823 323986 

secret11,y@digit.o~ 

Treasurer: Peter Roberts ARPS 
01926 420105 

treasurer@digit. o!ff.:J!!! 

Webmaster: Bill Henley LRPS 
01453 825068 

wehen/ey@mac.com 

Publicity and Website Updates: 
John Long ARPS 
01179 672231 

webquery@digitorg.uk 

KEY CONTACTS 
DIGITAL IMAGING GROUP 

Exhibitions: Alex Dufty LRPS 
01454 778485 

exhibition@digit.org. uk 

Dr Barry Senior FRPS 
01425 471489 

~ittlepics.freeserve.co.uk 

Graham Whistler FRPS 
01329-84 7944 

graham@gWpmultimedia.com 

Maureen Albright ARPS 
01672 540754 

maureen@maureenalbright.com 

Tony Healy ARPS 
+61 (0) 2 9958 1570 

tonyhealy@optusnet.com.au 

Vice-Chair and DIGIT 
Jim Buckley LRPS 
01932 843893 

editor@digit. o,g. uk 

DIGITAL REGIONAL ORGANISERS 
Members wishing to attend reglonal dlgltal Imaging meetings should contact 

the organisers llsted below for full details 

Eiger (East Anglia) 
Joy Hancock FRPS k!xandmike@woodview24.freeserve.co.uk 

Midlands 
Clive Haynes FRPS 

www.midig.org 
c/ive@crhfoto.co.uk 

Central Southern 
Moira Taylor LRPS 

no 1g,~_f!.f!~ide@onetel.com 

Wessex 
Maureen Albright ARPS 
www.wessex-dig.org.uk 

maureen@maureenalbright.com 

Yorl<shire 
Robert Croft LRPS 

http://yor1<shire-<figi.mysite.orange.co.uk/ 
robert.@robeltcro~ wanadoo. co. uk 

Scotland 
Alistair Knox LRPS 

akphoto@btintemet.com 

East Midlands 
Bob Rowe ARPS 

www.rpsdigital-em.org.uk 
bob.rowe 1 O@ntlworld.com 

Western 
Glenys Taylor ARPS 

g!!!!Jy_s.tay/or@tiscali.co.uk 

Southern 
Barry Senior FRPS 

bany@_littlepics. freeserve. co. uk 

South Wales 
Maureen Albright ARPS 

www .southwal es-dig.rps. o rg 
maureen@ma',!!eenaf b_nght. com 

And finally, when will you send us an article for DIGIT? Remember that everyone is learning and all experience is valuable. 
We look forward to hearing from you. Email to editor@digit.org.uk. Thank you. 

The Intellectual property rights of all materlal In DIGIT 1remaln with the authors 



The Annual General Meeting of the RPS Digital Imaging Group will be held on 
Sunday 22 April 2007 at 1100 

at The Old School House, Smethwick PhotoSoc Club Rooms, 
Churchbridge, Oldbury, West Midlands B69 2AX 

Easy access from MS, Junction 2 See http://www.theoldschoolhouse.com for club details and map 

Programme 

1030 Coffee 
1100 AGM 
1 Notice of meeting 
2 Formal adoption of the minutes of the previous AGM 
3 Matters arising from the previous minutes 
4 Annual Reports and accounts 
5 Chairman 
6 Treasurer 
7 Election of Officers 
8 Any other relevant business 
9 Date of next AGM 

The AGM will be followed at about 1130 by the Selection of Prints for the Exhibition 
1300 Lunch, which must be pre-booked, available in the lounge. Licensed bar. Or bring your own 
lunch. 
1400 - 1630 Lecture/Demonstration by Mel Gigg FRPS 
Mel Gigg is an extremely popular demonstrator of Photoshop, known to many members of the group for 
his innovative techniques accompanied by interesting and informative lectures. 

~~-- A charge of £5 will be made on the day for non-group members wishing to attend the lecture 

A two,courae luncb Is available at £7 per head. Booking and payment must be made no later than 12 ... 
_ _ luncbes at £7 each. Cheque enclosed for £ ____ _ 

Please return this booking sllp with your cheque and SAE to: 
G Taylor, 10 Shoredltch Road 
Taunton Somerset TA1 3BU 

For Membership, News, lnfonnatlon, Follo, Fo111m, Competition and much more 
- Log on to www.dltlto,r.uk 



DIGITAL IMAGING GROUP 2007 MEMBERS' EXHIBITION 

The 2007 print exhibition will be shown at the following locations: 

The Swindon Library Link Centre 
July 3rd - July 28th 

The Harrow Arts Centre, Hatch End, London NW 
September 3rd - September 15th 

The Old Schoolhouse, Oldbury, West Midlands 
September 24th - October 7th 

Any changes or additions will be displayed on the Website. 
If you have a suggestion for a showing please contact Alex Dufty - see below. 

Closing date for postal entries - Thursday 12th April 2007 
Selection of Exhibition at the AGM on Sunday 22nd April 2007 

You may also bring your entry to the Annual General Meeting 
of the Digital Imaging Group 

to be held at the Old Schoolhouse, Oldbury, West Midlands 
on Sunday 22nd April 2007. 

If you plan to bring your prints to the AGM, please remember to send this 
Entry Form, CD and cheque to Alex Dufty in advance 

Selectors for 2007: 
Shelagh Roberts FRPS 

Mel Gigg FRPS 
John Long ARPS 

*** 

Please read the rules carefully and complete the Entry Form overleaf 

*** 
Any queries, please contact the Exhibition Secretary Alex Dufty LRPS 

127 Bradley Avenue, Winterbourne, Bristol 8S36 1 HW 
Tel: 01454 778485 

Email: exhibition@digit.org.uk 

For Membership, News, lnfonnatlon, Follo, Forum, Competition and much more 
- Log on to www.dlglt.org.uk 



2007 MEMBERS' EXHIBITION - RULES 

1. A minimum of two prints and a maximum of three prints may be entered. They should be posted 
or delivered to the address on the reverse side of this entry form OR brought on the day if you are 
attending the AGM. In which case, the Entry Form, CD and cheque should be sent to Alex Duffy in 
advance. 

2. Each print must be marked on the reverse with the entrant's name, address and title as shown on 
the entry form. Mount size must be 40 x 50 cm. 

3 Prints accepted for previous DIG Exhibitions are not eligible for entry. 

4. Packing must be suitable for use in return posting of the prints unless collection arrangements have 
been previously agreed with the Exhibition Secretary. Please remember to include return postage, 
either in stamps, or by cheque. 

5. There is an entry fee of £4.00 per set of prints. All cheques made payable to: RPS DI GROUP. 

6. A CD must accompany the entry with the images in both TIFF and JPEG format if you want your 
images to be published on the Website, on the Exhibition CD and in the Exhibition edition of DIGIT. 
Entries for the Exhibition without the CD and files in the correct format will be accepted for the print 
exhibition but, regrettably, the images may not be able to be published. The file names on the CD 
MUST be the same as the print titles to allow us to identify the selected images. Please save your 
TIFFs at 300 ppi sized at 15cm on the longer side. Save the JPEGs sized at 500 pixels on the longer 
edge with a maximum file size of 95 KB. Mac users please ensure that the image is readable in PC 
format. See the special section in this issue of DIGIT for more details. 

7. Images to be on CD only please: NO FLOPPY DISCS this year. Write your name and print titles on 
the CD with a CD marker - no sticky labels please! 

8. Selection will take place following the AGM on April 22nd, and will be carried out by the judges listed 
overleaf. Each entrant will have one print accepted. A Gold Medal and six Ribbons will be awarded. 

9. Due to constraints on hanging space it may not be possible to display all the accepted prints at 
every venue. 

10. The utmost care will be taken of all prints but the Digital Imaging Group cannot be held responsi-
ble for any loss or damage during the exhibition or whilst in transit. 

ENTRY FORM - 2007 MEMBERS' EXHIBITION 
-

Name: RPS D1stmct1on: 

Address: 
RPS Membership Number: 

Email: Please write clearly in box below 

Telephone: 

Entry fee of £4 enclosed: Return postage of£ enclosed 

PRINT TITLES 

Print 1 
Print 2 

Print 3 
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